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1. ИНФОРМАЦИЯ О ПРОДУКТЕ 

1.1 Описание продукта 

 

COrDIS Y-next– набор реагентов для молекулярно-генетической 

идентификации личности на основе мультиплексного ПЦР-анализа 37 STR 

маркеров Y-хромосомы человека: DYS456, DYS389I, DYS533, DYS389II, 

DYS504, DYS19, DYS481, DYS525, DYS393, DYS392, DYS576, Y-GATA-A10, 

DYS391, DYS438, DYS458, DYS390, DYS449, DYS448, DYS445, DYS552, 
DYS460, DYS537, DYS439, DYS505, DYS437, DYS635, DYS385 a/b, DYF387S1 

a/b, DYS570, GGAAT1B07, DYS549, DYS643, Y-GATA-H4, DYS627, DYS518. 

 Анализ результатов ПЦР проводится методом капиллярного 

электрофореза с использованием автоматических генетических анализаторов с 

лазериндуцированной флуоресцентной детекцией. В наборе используется пять 

флуоресцентных красителей, характеризующихся разными длинами волн 

эмиссии для возможности одновременной детекции в разных каналах 

флуоресценции. Праймеры мечены пятью флуоресцентными красителями, 

детектируемыми в каналах Blue, Green, Yellow, Red, Purple. Размерный стандарт 

S550 мечен шестым флуоресцентным красителем и детектируется в отдельном 

канале Orange одновременно с продуктами ПЦР. 
Для получения полного STR-профиля образца достаточно 0.1 нанограмм 

недеградированной ДНК. При этом набор реагентов COrDIS «Y-NEXT» 

позволяет амплифицировать генетический материал в широком динамическом 

диапазоне концентраций ДНК. Данный эффект достигается благодаря 

5.1 Спектральная калибровка ______________________________________________ 18 
5.2     Подготовка и загрузка продуктов амплификации ___________________________ 23 
5.3     Создание проекта _____________________________________________________ 25 
5.4     Запуск анализа проекта ________________________________________________ 28 

6.1 Настройка программного обеспечения GeneMapper _________________________ 29 
6.2 Размерный стандарт S550 ______________________________________________ 33 
6.3 Диапазоны аллелей исследуемых локусов _________________________________ 34 
6.4 Амплификация контрольной   ДНК ______________________________________ 35 
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уникальной технологии нормирования сигнала целевого продукта реакции 

амплификации (технология нормирующей амплификации COrDIS STRICT). 

Исследование препаратов ДНК может проводиться без предварительной оценки 

и нормирования концентрации ДНК. Вне зависимости от количества исходной 

ДНК, вносимой в реакцию, финальное количество целевых ПЦР продуктов всегда 
находится на одном и том же уровне (оптимальном для проведения дальнейшего 

электрофоретического исследования). 

Общий объем реакции составляет 25 мкл. При работе с препаратами 

ДНК, полученными из образцов сравнения и содержащими заведомо достаточное 

для исследования количество генетического материала (например, при работе с 

препаратами ДНК, полученными из образцов буккального эпителия) ПЦР 

реакция может проводиться в объеме 10 мкл. Не рекомендуется снижать объем 

реакции в случае анализа низкокопийных препаратов ДНК, препаратов ДНК 

содержащих ингибиторы ПЦР, а также препаратов, содержащих 

деградированный генетический материал.  

Максимальный объем вносимого в реакцию раствора ДНК может 
составлять 15 мкл при общем объеме реакции 25 мкл. В случае проведения 

реакции амплификации в объеме 10 мкл максимальный объем вносимого в 

реакцию раствора ДНК может составлять 6 мкл. 

Набор валидирован для проведения ПЦР в амплификаторах: GeneAmp® 

9700, GeneAmp® 2720, ProFlex PCR System, SimpliAmp™ Thermal Cycler, Veriti™ 

96-Well Thermal Cycler.  

Анализ ПЦР-продуктов может проводиться с использованием 

генетических анализаторов ABI PRISM® 3130/3130XL/3500/3500XL (Applied 

Biosystems), Нанофор 05 (СИНТОЛ). 

1.2 Компоненты набора и состав 

 

Набор реагентов COrDIS Y-next, 200 реакций  

 
1. Реакционная смесь   1 пробирка, 1.0 мл 
2. Раствор активатора             1 пробирка, 1.0 мл 

3. Деионизованная вода  1 пробирка, 1.7 мл 
4. Контрольная ДНК MK01  1 пробирка, 0,1 нг/мкл  
5. Размерный стандарт S550  2 пробирки, 120 нанесений 
6. Аллельная лестница  1 пробирка, 50 нанесений 

 

Реакционная смесь представляет собой раствор, содержащий компоненты 

полимеразной цепной реакции включая Taq-полимеразу, смесь дНТФ, 

реакционный буфер, праймерную смесь. 

Раствор активатора используется для активации реакционной смеси. 

Содержит буферный раствор и ионы магния Mg2+ в качестве активатора 
полимеразной цепной реакции. 
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Деионизованная вода предназначена для доведения реакций до рабочего 

объема. 

Контрольная ДНК МК01 представляет собой 10 нг высокомолекулярной 

геномной ДНК мужчины в концентрации 0.1 нг/мкл с известным генотипом по 

всем исследуемым локусам. Предназначена для контроля этапов амплификации, 
электрофореза и анализа данных. 

Размерный стандарт S550 представляет собой лиофилизированную смесь 

флуоресцентно-меченных фрагментов ДНК разной длины, меченых 

спектральным аналогом LIZ, детектируемым в канале Orange. Размерный 

стандарт S550 содержит 26 фрагментов ДНК разной длины (н.п.): 60, 70, 80, 90, 

100, 120, 140, 160, 180, 200, 220, 230, 240, 260, 280, 300, 320, 340, 360, 380, 400, 

420, 440, 450, 500, 550. Размерный стандарт S550 используется на этапе 

капиллярного электрофореза, вносится в каждый капилляр одновременно с 

исследуемым образцом и служит опорным внутренним стандартом для 

построения кривой подвижности амплифицированных фрагментов исследуемого 

образца. Благодаря высокой плотности фрагментов стандарта S550 
обеспечивается высокая точность и воспроизводимость определения длины 

амплифицированных фрагментов исследуемого образца. Перед использованием 

требует добавления воды (п. 2.1). 

Аллельная лестница представляет собой лиофилизированную смесь из 

флуоресцентно-меченных амплифицированных фрагментов ДНК, 

соответствующих аллельным вариантам исследуемых локусов. Аллельная 

лестница используется на этапе капиллярного электрофореза, анализируется 

параллельно с каждой серией образцов для идентификации аллельных вариантов 

исследуемых локусов. Аллельная лестница содержит ПЦР-продукты и при 

несоблюдении мер предосторожности может быть источником контаминации 

остальных реагентов. Поставляется в лиофилизированном виде. Перед 

использованием требует добавления воды (п. 2.2). 
 

1.3 Условия хранения 

 

Компоненты набора необходимо хранить при температуре от -15°C до  

-25°C. После начала использования допускается хранение при температуре от 

+2°C до +8°C в течение 1 месяца. Длительное хранение компонентов набора 

рекомендовано при температуре от -15°C до -25°C. В соответствии с 

действующими Техническими Условиями допускается режим транспортировки 

при температуре не выше +25°C в течении 14 календарных дней.  
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1.4 Основные характеристики набора 

 

Количество одновременно анализируемых маркеров – 37; 

Список одновременно анализируемых локусов:  

DYS456, DYS389I, DYS533, DYS389II, DYS504, DYS19, DYS481, DYS525, 

DYS393, DYS392, DYS576, Y-GATA-A10, DYS391, DYS438, DYS458, DYS390, 

DYS449, DYS448, DYS445, DYS552, DYS460, DYS537, DYS439, DYS505, 

DYS437, DYS635, DYS385 a/b, DYF387S1 a/b, DYS570, GGAAT1B07, DYS549, 

DYS643, Y-GATA-H4, DYS627, DYS518 

Количество флуоресцентных меток, используемых в наборе – 6 

Оптимальное количество вносимой ДНК (в реакцию): 0.2–200 нг 

Предел чувствительности: 0.1 нг (в реакцию) 
 

1.5 Гарантии качества 

 

Качество каждого компонента набора проверено и контролируется в 

процессе производства. Каждый выпущенный лот реагентов регулярно 

проверяется на соответствие заявленным характеристикам в течение 18 месяцев. 

В случае возникновения вопросов относительно качества набора COrDIS «Y-

NEXT», просим незамедлительно связаться с ООО “ГОРДИЗ”. 

 

1.6 Сопутствующие материалы 

 

Необходимые материалы, не входящие в набор: 

 

Спектральный калибратор CS6   (ООО “ГОРДИЗ”) 
Бины и панели для GeneMapper (ООО “ГОРДИЗ”, предоставляются                   

бесплатно по запросу).  

2.  РАЗВЕДЕНИЕ СУХИХ КОМПОНЕНТОВ 

2.1 Размерный стандарт S550 

 
Сразу после получения набора необходимо извлечь комплект для 

электрофореза и хранить отдельно в зоне для работы с ПЦР продуктами в 

темном месте при температуре +2 – +8 °C.  

Перед использованием добавить 120 мкл деионизованной воды в 

пробирку с сухим размерным стандартом S550. Тщательно перемешать на 
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вортексе и собрать на дне пробирки коротким центрифугированием. После 

разведения готовый раствор допускается хранить при температуре +2 – +8 °C в 

течение месяца. Длительное хранение готового раствора рекомендовано при 

температуре от -15°C до -25°C. Для проведения капиллярного электрофореза 

добавить 1 мкл стандарта S550 в каждую лунку планшета, содержащую 
формамид и ПЦР продукт. 

Объем вносимого в лунку размерного стандарта S550 может быть снижен 

до 0.3 мкл для увеличения возможного количества инжекций. При этом для 

оптимизации уровня сигнала рекомендуется использовать 1 мкл стандарта S550 

для каждого исследуемого препарата. Дополнительный размерный стандарт S550 

может быть заказан по каталожному номеру S550-10. 

2.2  Аллельная лестница 

 
Сразу после получения набора, пробирку с аллельной лестницей 

необходимо извлечь из коробки и хранить отдельно в зоне для работы с ПЦР 

продуктами в темном месте. Для получения рабочего раствора добавить в 

пробирку с сухой аллельной лестницей 50 мкл деионизованной воды, 

поставляемой с набором. Тщательно перемешать на вортексе и собрать на дне 

пробирки центрифугированием в течение нескольких секунд. После разведения 

готовый раствор допускается хранить при температуре +2 – +8 °C в течение 1 

месяца. Длительное хранение готового раствора рекомендовано при 

температуре от -15°C до -25°C. Для проведения капиллярного электрофореза 
необходимо добавить 1 мкл аллельной лестницы в смесь формамида и 

размерного стандарта. При недостаточной чувствительности генетического 

анализатора допускается увеличение объема вносимой в лунку аллельной 

лестницы до 2 мкл. 

3.  СТАНДАРТНЫЙ ПРОТОКОЛ АМПЛИФИКАЦИИ 

3.1 Постановка реакции в 25 мкл 

Набор реагентов COrDIS «Y-NEXT» позволяет проводить 

амплификацию в широком диапазоне значений концентрации исследуемых 

препаратов. Так как в норме концентрация препаратов ДНК редко превышает 200 

нг/мкл, предварительное определение точного значения концентрации ДНК в 

исследуемых препаратах не требуется. 
В каждую пробирку необходимо внести 5 мкл Реакционной смеси, 5 мкл 

Активатора. Затем внести до 15 мкл раствора исследуемой геномной ДНК в 

количестве 0.2–200 нг. При необходимости общий объем реакции довести до 25 

мкл деионизованной водой, поставляемой в составе набора.  
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Компоненты набора Объем на 1 реакцию 
Реакционная смесь      5 мкл 
Раствор Активатора       5 мкл 
Геномная ДНК (0.2–200 нг)                 до 15 мкл 
Деионизованная вода, до конечного объема  25 мкл                     

 

Необходимо учитывать, что в некоторых случаях при добавлении 

ДНК в объеме более 10 мкл возможно внесение избытка ингибирующих 

веществ в реакцию, что может приводить к снижению чувствительности.  

После внесения всех компонентов, реакционную смесь необходимо 

тщательно перемешать до гомогенного состояния 5–8 кратным пипетированием, 

либо используя вортекс. При необходимости собрать раствор на дне пробирки 

коротким центрифугированием. Тщательное перемешивание необходимо для 

максимальной эффективности реакции. 

С каждой серией исследуемых образцов необходимо амплифицировать 

один положительный контроль (15 мкл контрольной ДНК, поставляемой с 

набором) и один отрицательный контроль (15 мкл деионизованной воды вместо 
ДНК). 

3.2 Постановка реакции в 10 мкл 

Протокол предназначен для работы с высококонцентрированными 

препаратами ДНК, содержащими заведомо пригодный для исследования 

генетический материал человека (например, препаратами ДНК, полученными из 

образцов буккального эпителия или иных образцов сравнения). Не 

рекомендуется снижать объем реакции в случае анализа низкокопийных 

препаратов ДНК, препаратов ДНК содержащих ингибиторы ПЦР, а также 

препаратов, содержащих деградированный генетический материал.  

В каждую пробирку необходимо внести 2 мкл Реакционной смеси, 2 мкл 

Активатора. Затем внести до 6 мкл раствора исследуемой геномной ДНК в 
количестве 0.2–200 нг. 

 
Компоненты набора Объем на 1 реакцию 

Реакционная смесь      2 мкл 

Раствор Активатора       2 мкл 

Геномная ДНК (0.2–200 нг)              до  6 мкл  
Деионизованная вода, до конечного объема  10 мкл 

 

Необходимо учитывать, что в некоторых случаях при добавлении 

ДНК в объеме более 4 мкл возможно внесение избытка ингибирующих 

веществ в реакцию, что может приводить к снижению чувствительности.  

После внесения всех компонентов, реакционную смесь необходимо 

тщательно перемешать до гомогенного состояния 5–8 кратным пипетированием, 

либо используя вортекс. При необходимости собрать раствор на дне пробирки 
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коротким центрифугированием. Тщательное перемешивание необходимо для 

максимальной эффективности реакции. 

С каждой серией исследуемых образцов необходимо амплифицировать 

один положительный контроль (6 мкл контрольной ДНК, поставляемой с 

набором) и один отрицательный контроль (6 мкл деионизованной воды вместо 
ДНК). 

3.3 Стандартная программа амплификации 

 

Приведенные ниже условия амплификации рекомендуются в качестве 

стандартных и применимы при работе по стандартному протоколу. Изменение 

количества циклов амплификации недопустимо. 

  

Параметры ПЦР: 

____________________________ 

94°C 2 мин 

 
96°C 5 сек 

58°C 30 сек   28 циклов 

72°C 30 сек 

 

96°C 5 сек 

62°C 30 сек   5 циклов 

72°C 30 сек 

 

68°C 15 мин 

 

15°C  ∞ 
 

После завершения программы амплификации ПЦР продукты можно 

хранить неделю при +4°C – +8°C в защищенном от света месте. В случае, если 

амплифицированные продукты необходимо хранить более недели, 

рекомендуется заморозка при -20°C.  

4. ЭЛЕКТРОФОРЕЗ НА АНАЛИЗАТОРЕ ABI PRISM 3500/3500XL 

 
При работе с генетическим анализатором ABI PRISM и последующем 

анализе флуоресцентных профилей в программе GeneMapperTM, необходимо 

следовать инструкциям пользователя от производителя оборудования. 

Для корректной визуализации флуоресцентных меток COrDIS «Y-

NEXT» необходимо проведение спектральной калибровки для набора красителей 
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“CS6”, который должен быть создан пользователем в соответствии с пунктом 4.1 

и откалиброван с использованием спектрального калибратора CS6. 

4.1 Создание матрикса / спектральная калибровка 

 
Анализ продуктов амплификации COrDIS «Y-NEXT» на генетическом 

анализаторе возможен только после проведения калибровки с 6-ти цветным 

спектральным калибратором CS6 (не поставляется с набором, заказывается 

отдельно по каталожному номеру CS6). Спектральный калибратор содержит 

смесь 6-ти фрагментов разной длины, меченных разными флуоресцентными 

красителями. Эти красители использованы в наборе для мечения ПЦР-продуктов 

и размерного стандарта S550. 
Для приготовления рабочего раствора спектрального калибратора CS6 

добавить 50 мкл деионизованной воды в пробирку, содержащую 

лиофилизированную смесь красителей CS6 и инкубировать при комнатной 

температуре 2 мин. Затем тщательно перемешать раствор на вортексе и собрать 

на дне пробирки коротким центрифугированием. Готовый раствор можно 

хранить в темном месте при температуре +2°C – +8°C до 2 недель. Для более 

длительного хранения раствор следует хранить при температуре -15°C – 25°C. 

Следует избегать повторного размораживания. 

При проведении спектральной калибровки настоятельно 

рекомендуется использовать только чистые септы, новый буферный раствор и 

воду. Использование ранее использованных септ при проведении спектральной 
калибровки может приводить к попаданию ранее исследованных меченных ПЦР 

продуктов в область анализа, и препятствовать успешному анализу 

спектрального калибратора. 

 

Подготовка спектрального калибратора для калибровки (ABI 3500 /8 

капилляров) 

 

Hi-DiTM формамид  80 мкл 

Раствор CS6     8 мкл 

 

Добавить по 10 мкл смеси в лунки A01-H01 96-луночного планшета. 

При необходимости удалить пузыри со дна лунок центрифугированием. 
 

 

Подготовка спектрального калибратора для калибровки (ABI 3500XL/ 24 

капилляра) 

 

Hi-DiTM формамид  240 мкл 

Раствор CS6     24 мкл 
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Добавить по 10 мкл смеси в лунки A01- H03 96-луночного планшета. 

При необходимости удалить пузыри со дна лунок центрифугированием. 

 

Спектральная калибровка 

 
Шаг А – Создание Dye Set для спектральной калибровки 

 

Перейти в раздел Library в программе Data Collection Software. 

В разделе Analyze выбрать вкладку Dye Sets. В открывшемся меню нажать 

кнопку Create (откроется диалоговое окно создания нового Dye Set). В 

появившемся окне указать параметры нового Dye Set: 

 

Dye Set Name   CS6 

Chemistry   Matrix standard 

Dye Set Template J6 Template 

Arrange Dyes  оставить без изменений 
Parameters: 

Matrix condition number  20 

Upper limit 

Minimal Quality Score  0.8 

 
 

Нажать кнопку Save. Новый Dye Set (CS6) появится в списке. 

 

Шаг B – Проведение спектральной калибровки 
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Перейти в раздел Maintenance в программе Data Collection Software. В 

разделе Calibrate, выбрать вкладку Spectral Calibration. В открывшемся окне 

выбрать количество лунок в используемом планшете (Number of Wells) и 

позицию планшета в приборе (Plate Position). В пункте Chemistry Standard 

выбрать Matrix standard. В пункте Dye Set выбрать CS6. Запустить процесс 
калибровки нажав кнопку Start Run. 

 

Шаг С – Оценка результатов спектральной калибровки 

 

После завершения работы прибора проверить статус каждого капилляра 

(pass или fail). Высота пиков должна быть не менее 2.000 rfu, но ниже 15.000 rfu 

(оптимальный диапазон между 5000 и 10000 rfu). 

Калибровка должна быть успешной минимум для 6 из 8 капилляров (или 

для 18 из 24 капилляров, соответственно). При использовании CS6 в качестве 

спектрального калибратора, в окне профиля калибровки (Intensity vs Pixel 

Number) должна отражаться следующая последовательность пиков. 
 

 

 

 

В случае успешной калибровки сохранить полученные результаты, нажав 

кнопку Accept. 

4.2 Создание Instrument Protocol 

 

Перейти в раздел Library в программе Data Collection Software. 
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В разделе Analyze, выбрать вкладку Instrument Protocols. В открывшемся меню 

нажать кнопку Create (откроется диалоговое окно создания нового Instrument 

Protocol). В появившемся окне указать параметры нового Instrument Protocol: 

 

Application Type   HID 
Dye Set     CS6 

Run Module например “HID36_POP4” (выбрать протокол 

соответствующий параметрам системы) 

Protocol Name   Y-next 
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Рекомендуемые параметры электрофореза для генетического анализатора ABI 

3500: 

 

Параметр  Значение 

Oven Temperature      60 
PreRun Voltage      15 

PreRun Time                 180 

Injection Voltage     1.2 

Injection Time      10 

Data Delay Time        1 

Run Voltage   13.0 

Run Time  1600 

 

Нажать кнопку Save. 

 

В зависимости от состояния используемого прибора параметр Injection Time 
может быть скорректирован пользователем для достижения оптимальной 

амплитуды флуоресцентного сигнала (5–15 sec.).  Параметр Run Time также 

может быть скорректирован пользователем в случае, если рекомендуемое время 

фореза является избыточным (все фрагменты размерного стандарта 

детектируются существенно раньше отведенного времени) или недостаточным 

(не все фрагменты размерного стандарта детектируются за отведенное время). 

Оптимальное время фореза в наибольшей степени зависит от текущего состояния 

капилляров и полимера в генетическом анализаторе и может меняться со 

временем. 

 

4.3 Создание Size Standard 

 

Перейти в раздел Library в программе Data Collection Software.В 

разделе Analyze, выбрать вкладку Size Standards. В открывшемся меню нажать 

кнопку Create (откроется диалоговое окно создания нового Size Standard). В 

появившемся окне указать параметры нового Size Standard. Размерный стандарт 

S550 содержит 26 фрагментов ДНК разной длины (н.п.): 60, 70, 80, 90, 100, 120, 

140, 160, 180, 200, 220, 230, 240, 260, 280, 300, 320, 340, 360, 380, 400, 420, 440, 

450, 500, 550. 

 

Нажать кнопку Save. 
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4.4 Создание QC Protocol 

 

Перейти в раздел Library в программе Data Collection Software. 

В разделе Analyze, выбрать вкладку QC Protocols. В открывшемся меню нажать 

кнопку Create (откроется диалоговое окно создания нового QC Protocol). В 

появившемся окне указать параметры нового QC Protocol: 
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Нажать кнопку Save. 
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4.5 Создание Assay 

 

Перейти в раздел Library в программе Data Collection Software. 

В разделе Manage, выбрать вкладку Assays. В открывшемся меню нажать кнопку 

Create (откроется диалоговое окно создания нового Assay). В появившемся окне 

указать параметры нового Assay: 

 

Assay Name    Y-next 

Application Type  HID 

Instrument Protocol  Y-next 

 

 
 

Нажать кнопку Save. 

4.6 Подготовка и загрузка продуктов амплификации 

 

Для загрузки образцов в прибор необходимо приготовить смесь Hi-DiTM 

формамида и размерного стандарта S550 в следующем соотношении: 

 

Компонент    Объем на один образец 
Hi-DiTM формамид  10.0 мкл 

Размерный стандарт S550 1 мкл 
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При расчете объемов компонентов смеси следует учесть, что 

формамидом должны быть заполнены все лунки, в которых будет происходить 

инжекция, в том числе и лунки, не содержащие образцы. Как минимум одна лунка 

при анализе каждой серии образцов должна содержать аллельную лестницу. 

После перемешивания добавить по 10 мкл смеси в каждую лунку 
планшета. Затем внести в лунки по 1 мкл ПЦР-продукта или аллельной лестницы. 

При необходимости удалить пузыри со дна лунок планшета коротким 

центрифугированием.  

 

Накрыть планшет резиновым ковриком и провести температурную 

денатурацию по схеме: 

__________ 
95°C 2 мин 
4°C _ 1 мин 

 

Загрузить планшет с денатурированными образцами в прибор в 

соответствии с инструкцией пользователя ABI PRISM® Genetic Analyzer. 

 

В состав набора входит аллельная лестница, рассчитанная на проведение 50 

инжекций (при нанесении 1 мкл аллельной лестницы в лунку планшета). При 

недостаточной чувствительности генетического анализатора допускается 

увеличение объема вносимой в лунку аллельной лестницы до 2 мкл. 

Размерный стандарт S550 рассчитан на 240 инжекций. При 

необходимости, объем вносимого в лунку размерного стандарта S550 может быть 

снижен до 0.3 мкл для увеличения возможного количества инжекций. Благодаря 
высокой плотности фрагментов стандарта S550 обеспечивается высокая точность 

и воспроизводимость определения длины амплифицированных фрагментов 

исследуемого образца без потери качества анализа. 

4.7 Запуск прибора 

 

Шаг A – Создание планшета 

 

Перед началом анализа необходимо создать Plate (планшет), 

описывающий расположение образцов на планшете и содержащий инструкции 

для прибора. Для этого необходимо перейти в меню Create New Plate 

программы Data Collection Software. Появится диалоговое окно, в котором 
необходимо указать параметры нового планшета. 

 

Нажать кнопку OK. Появится новая таблица со схемой исследуемого планшета. 
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Шаг B – Заполнение таблицы 

 

Для всех анализируемых лунок планшета необходимо указать: 

Sample name   имя объекта 

Sample type   тип образца 
Assay     Y-next 

Filename convention  структура имени файла 

Results group   параметры сохранения файлов 

 

Шаг C – Запуск прибора и информация о статусе прибора 

 

После создания схемы расположения образцов на планшете, нажмите на 

кнопку Link Plate for Run. В открывшемся окне указать положение планшета в 

приборе и запустить электрофорез нажатием кнопки Start Run. 

5. ЭЛЕКТРОФОРЕЗ НА АНАЛИЗАТОРЕ «НАНОФОР 05»  

 

При работе с генетическим анализатором Нанофор 05 и последующем 

анализе флуоресцентных профилей в программе GeneMarker HID, необходимо 

следовать инструкциям пользователя от производителя оборудования. 

Для корректной визуализации флуоресцентных меток COrDIS «Y-

NEXT» необходимо проведение спектральной калибровки для набора красителей 

“CS6”, который должен быть создан пользователем в соответствии с пунктом 5.1 

и откалиброван с использованием спектрального калибратора CS6. 
 

5.1 Спектральная калибровка 

 
Анализ продуктов амплификации COrDIS «Y-NEXT» на генетическом 

анализаторе возможен только после проведения калибровки с 6-ти цветным 

спектральным калибратором CS6 (не поставляется с набором, заказывается 

отдельно по каталожному номеру CS6). Спектральный калибратор содержит 

смесь 6-ти фрагментов разной длины, меченных разными флуоресцентными 

красителями. Эти красители использованы в наборе для мечения ПЦР-продуктов 

и размерного стандарта S550. 

Для приготовления рабочего раствора спектрального калибратора CS6 

добавить 50 мкл деионизованной воды в пробирку, содержащую 

лиофилизированный CS6 и инкубировать при комнатной температуре 2 мин. 

Затем тщательно перемешать раствор на вортексе и собрать на дне пробирки 

коротким центрифугированием. Готовый раствор можно хранить в темном месте 
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при температуре +2°C – +8°C до 2 недель. Для более длительного хранения 

раствор следует заморозить. Следует избегать повторного размораживания. 

Перед проведением спектральной калибровки: 

1. Приготовьте 50 мл свежего ТАПС буфера однократного разведения. Для 

этого смешайте 45 мл деионизованной воды и 5 мл 10-кратного ТАПС 

буфера. Смесь перемешивать переворачиванием не менее 30 раз. 

2. Промойте деионизованной водой контейнеры для воды, слива и 

катодного буфера. 

3. Смените септы контейнеров для воды, слива и катодного буфера. 

4. При замене катодного буфера также всегда заменяйте анодный буфер 

(также при замене анодного буфера всегда заменяйте катодный буфер). 

Катодный и анодный буферы должны быть разлиты из одного и того же 

разведения 1х ТАПС буфера. 

5. Залейте свежий буфер в контейнеры для катодного и анодного буфера, 

деионизованную воду – в контейнеры для воды и для слива. 

 

Подготовка спектрального калибратора для калибровки  

 

Hi-Di  формамид  80 мкл 

Раствор CS6     8 мкл 
 

Добавить по 10 мкл смеси в лунки A-H 96-луночного планшета. 

При необходимости удалить пузыри со дна лунок центрифугированием. 

 

Спектральная калибровка 

 

В главном окне программы НАНОФОР 05 в пункте меню Сервис выбрать 

опцию Спектральная калибровка. 
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Появится окно Выбор ряда спектрального калибратора. 

 

 
 

При нажатии кнопки Далее появляется окно Спектральная калибровка.  

В выпадающем списке нужно выбрать Модуль управления:   

 

Gordiz-CS_Spectr_PDMA4_36 
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При необходимости в Модуле управления можно изменить параметры 

выбранной программы и сохранить его, либо оставить программу без 

изменений. 

 

Из выпадающего списка Набор красителей выберите Gordiz-CS6.  
 

 
 

Появится окно Спектральная калибровка. Нажмите Принять. 

 

 
 

Нажмите ОК, чтобы перейти к запуску Спектральной калибровки: 
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Для запуска спектральной калибровки в меню главного окна программы 

НАНОФОР 05 нажать кнопку  Запустить или в пункте меню Действия 

выбрать опцию Запустить. 

 

 
 

После завершения программы измерений данные анализируются автоматически. 

В результате открывается окно Набор красителей с рассчитанными оценками 

качества спектральной калибровки по каждому капилляру. Возможны три 

варианта оценки качества: Хорошее, Удовлетворительное и Плохое. В 

последнем случае калибровку рекомендуется переставить.  

Если качество спектральной калибровки для всех капилляров Хорошее 

(допускается для одного капилляра – Удовлетворительно), нажать кнопку 

Принять. Калибровка сохранится под заданным в строке Набор названием и со 

временем ее проведения в формате год.месяц.число час.минута начала 

калибровки. 
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Типичный вид данных после применения матриц: 

5.2 Подготовка и загрузка продуктов амплификации 
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Для загрузки образцов в прибор необходимо приготовить смесь Hi-Di формамида 

и размерного стандарта S550 в следующем соотношении: 

 

Компонент    Объем на один образец 

Hi-Di формамид   10.0 мкл 
Размерный стандарт S550 1 мкл 

 

При расчете объемов компонентов смеси следует учесть, что 

формамидом должны быть заполнены все лунки, в которых будет происходить 

инжекция, в том числе и лунки, не содержащие образцы. Как минимум одна лунка 

при анализе каждой серии образцов должна содержать аллельную лестницу. 

После перемешивания добавить по 10 мкл смеси в каждую лунку 

планшета. Затем внести в лунки по 1 мкл ПЦР-продукта или аллельной лестницы. 

При необходимости удалить пузыри со дна лунок планшета коротким 

центрифугированием.  

 
Накрыть планшет резиновым ковриком и провести температурную 

денатурацию по схеме: 

____________ 

95°C 2 мин 

4°C ___1 мин 
 

Загрузить планшет с денатурированными образцами в прибор в 

соответствии с инструкцией пользователя от производителя оборудования. 

 

В состав набора входит аллельная лестница, рассчитанная на проведение 50 

инжекций (при нанесении 1 мкл аллельной лестницы в лунку планшета). При 

недостаточной чувствительности генетического анализатора допускается 

увеличение объема вносимой в лунку аллельной лестницы до 2 мкл. 

Размерный стандарт S550 рассчитан на 240 инжекций. При 

необходимости, объем вносимого в лунку размерного стандарта S550 может быть 

снижен до 0.8 мкл для увеличения возможного количества инжекций. Благодаря 
высокой плотности фрагментов стандарта S550 обеспечивается высокая точность 

и воспроизводимость определения длины амплифицированных фрагментов 

исследуемого образца без потери качества анализа. 

Дополнительный размерный стандарт S550 может быть заказан по 

каталожному номеру S550-10. 
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5.3 Создание проекта 

Для создания нового проекта в главном окне программы НАНОФОР 05 в пункте 

меню Проект выбрать опцию Создать. В открывшемся окне Свойства проекта 

ввести имя оператора, название проекта. Убедиться в соответствии типа 

Пластика – Стрип / Планшет. При необходимости выбрать верный варианты 

типа пластика. Нажать кнопку Принять.  

   

 

Откроется главное окно Описание проекта.  
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Внести информацию об образцах: заполнить названия образцов и задать 

Программу Анализа (ПА). 

 

На поле ПА нужного ряда нажать на левую кнопку мыши два раза. 

Откроется окно Программа анализа.  

 

В графе Тип анализа выбрать: Фрагментный  

В графе Модуль управления открыть выпадающий список. Выбрать 

HID_600_PDMA4_36 

В графе Набор красителей выбрать Gordiz-CS6. 

 

Нажать кнопку Принять. Откроется окно Описание проекта, вкладка 

Планшет, с заданной Программой анализа.  
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Нажать кнопку Принять. Откроется главное окно программы НАНОФОР 05 и в 

графе Статус в выбранном ряду проекта появится надпись Готов к анализу. 
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5.4 Запуск анализа проекта 

Для запуска анализа, после описания всех загруженных образцами рядов проекта, 

в меню главного окна программы НАНОФОР 05 нажать кнопку  Запустить 

или в пункте меню Действия выбрать опцию Запустить.  

Появится окно Свойства проекта. 

 

В открывшемся окне Свойства проекта ввести/изменить имя оператора, 

название проекта, при необходимости – указать путь сохранения дополнительной 

копии данных (если дополнительная копия данных не нужна – это поле 

оставляется пустым). Убедиться в соответствии типа Пластика – Стрип / 

Планшет. При необходимости выбрать верный вариант типа пластика. 
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Нажать Принять. Активируется главное окно программы НАНОФОР 05. Первый 

анализируемый ряд проекта выделится зеленым цветом, а в графе статус появится 

надпись Измерение.  

В нижней части окна рядом с надписью Лазер серый индикатор должен стать 

красным — это означает, что лазер включен.  

В конце строки Текущая отобразится время до конца текущего анализа, а в конце 

строки Все — время до конца анализа всех рядов проекта.    

В зависимости от состояния используемого прибора параметр Время ввода 

пробы может быть скорректирован пользователем для достижения оптимальной 

амплитуды флуоресцентного сигнала (5–15 sec.).  Параметр Время 

электрофореза также может быть скорректирован пользователем в случае, если 
рекомендуемое время фореза является избыточным (все фрагменты размерного 

стандарта детектируются существенно раньше отведенного времени) или 

недостаточным (не все фрагменты размерного стандарта детектируются за 

отведенное время). Оптимальное время фореза в наибольшей степени зависит от 

текущего состояния капилляров и полимера в генетическом анализаторе и может 

меняться со временем. 

6. АНАЛИЗ ДАННЫХ 

6.1 Настройка программного обеспечения GeneMapper 

 

Полученные данные могут быть проанализированы с использованием 
программного обеспечения GeneMapper ID и GeneMapper ID-X. 

Программное обеспечение GeneMapper требует предварительной 

настройки параметров анализа. Параметры анализа для наборов COrDIS могут 

быть импортированы в программу из файлов настроек, предоставляемых 

производителем по запросу. 

Для анализа результатов электрофореза с использованием программного 

обеспечения GeneMapper необходимо произвести следующие действия: 

 

1) Произвести импорт файлов панелей и бинов 

Выбрать пункт меню Tools-> Panel Manager. 
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В левом верхнем сегменте открывшегося окна установить курсор на позицию 

Panel Manager. 

 

 
 

 

Затем в меню выбрать File-> Import panels. 
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В открывшемся окне найти и выбрать файл с панелями (например, файл Y-next). 

Загрузить нажатием кнопки Import.  

 

 
 

 
В левом верхнем сегменте окна выбрать загруженную панель (Например, Y-next), 

затем в меню выбрать File-> Import bin set. В открывшемся окне найти и выбрать 
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файл с бинами (Например, файл Y-next_bins). Загрузить нажатием кнопки Import. 

Нажать кнопки Apply и OK. 

 

2) Произвести импорт настроек размерного стандарта 

 

Выбрать пункт меню Tools> GeneMapper Manager.  

 

 
 
В открывшемся окне выбрать вкладку Size Standards. 

 

 
 

Загрузить файл настроек размерного стандарта нажатием кнопки Import. Нажать 

кнопку Done. 

 

3) Создать новый метод анализа 

Выбрать пункт меню Tools -> GeneMapper Manager.  
открывшемся окне выбрать вкладку Analysis Methods.  
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Нажать кнопку Import и загрузить файл настроек Метода Анализа. Нажать 

кнопку Done. Сохранить изменения. 

 

 

 
 

6.2 Размерный стандарт S550 

 

Ниже приводится пример электрофореграммы с сигналами фрагментов 

размерного стандарта S550 в канале детекции Orange. Обозначения 26 

фрагментов ДНК приводятся в соответствии с их размером: 60, 70, 80, 90, 100, 
120, 140, 160, 180, 200, 220, 230, 240, 260, 280, 300, 320, 340, 360, 380, 400, 420, 

440, 450, 500, 550.  

 

 
Рисунок 1. Электрофореграмма размерного стандарта S550. Размеры фрагментов.  
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6.3 Диапазоны аллелей исследуемых локусов 

№ Локус Канал 

детекции 

Аллели 

МК01 

Диапазон 

длин 

фрагментов 

Диапазон 

аллелей 

1.  DYS456 синий 16 74-133 9-23 

2.  DYS389 I синий 13 145-187 8-18 

3.  DYS533 синий 12 202-252 6-18 

4.  DYS389 II синий 30 252-306 23-36 

5.  DYS504 синий 13 311-365 11-21 

6.  DYS19 синий 13 372-419 8-19 

7.  DYS481 синий 22 426-477 16-32 

8.  DYS525 синий 10 482-517 6-14 

9.  DYS393 зеленый 13 101-158 6-19 

10.  DYS392 зеленый 11 174-231 3-21 

11.  DYS576 зеленый 18 247-326 8-26 

12.  Y-GATA-A10 зеленый 12 330-366 10-19 

13.  DYS391 зеленый 10 370-425 4-17 

14.  DYS438 зеленый 10 426-499 5-19 

15.  DYS458 желтый 15 107-160 10-23 

16.  DYS390 желтый 25 161-218 16-30 

17.  DYS449 желтый 32 219-298 22-41 

18.  DYS448 желтый 20 299-368 14-25 

19.  DYS445 желтый 10 369-404 10-14 

20.  DYS552 желтый 23 405-436 23-29 

21.  DYS460 желтый 10 437-475 6-15 

22.  DYS537 желтый 11 480-511 8-15 

23.  DYS439 красный 13 115-166 5-17 

24.  DYS505 красный 13 172-203 9-15 

25.  DYS437 красный 14 204-251 9-20 

26.  DYS635 красный 22 256-322 15-31 

27.  DYS385 a/b красный 16,18 323-418 6-29 

28.  DYF387S1 a/b красный 34,37 461-532 28-45 

29.  DYS570 фиолетовый 20 103-180 9-27 

30.  GGAAT1B07 фиолетовый 12 201-233 7-13 

31.  DYS549 фиолетовый 13 234-279 7-16 

32.  DYS643 фиолетовый 13 280-346 4-17 

33.  Y-GATA-H4 фиолетовый 12 347-399 8-20 

34.  DYS627 фиолетовый 22 400-472 10-27 

35.  DYS518 фиолетовый 39 473-549 32-50 
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6.4 Амплификация контрольной   ДНК 

 

 

 

 

 

 

 

 

Рисунок 2 Результата анализа Контрольной ДНК MK01. 
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6.5 Аллельная лестница 

 
 

 

 

 

 

 

Рисунок 3. Аллельная лестница COrDIS «Y-NEXT».  
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7. ИНФОРМАЦИЯ О ФИРМЕ ПРОИЗВОДИТЕЛЕ 

 

Производитель: ООО «ГОРДИЗ» 

Юридический и почтовый адрес: 143026 г. г. Москва, территория 

инновационного центра Сколково, ул. Большой Бульвар, д.42, стр. 1, пом.337 

Телефон/факс: +7 (499) 670-40-41, 

Домашняя страница: www.gordiz.ru 

e-mail: gordiz@gordiz.ru 

8. ВЕРСИЯ ДОКУМЕНТА 
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